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The following pages explain the formatting and design elements (aka ‘Look & 
Feel’) of the new PowerPoint Theme. This will enable you to develop 
presentations with formatting that is consistent with the new (Company) 
standards.

These instructions are intended to be used in conjunction with the  ‘PowerPoint 
Theme.thmx’ and ‘Samples and Appendix Slides.pptx’ files, which includes the 
samples referenced in this deck.

The steps outlined here are required to maintain the Look & Feel of all 
PowerPoint presentations for the organization. The extra effort will ensure 
professional and consistent deliverables throughout the organization.

Introduction to (company) Theme



Creating a New Presentation
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To create a new presentation with the  ‘PowerPoint 
Theme_2017.thmx’ file (once it has been saved to a location on 
your system) double-click on the file. This will open a new, un-
named presentation, and will automatically create the cover page.

Creating a New Presentation

To add pages, click on the ‘New Slide’ button. This will add one page, 
in the default ‘Main Content” layout.

Or, if you prefer a different layout, click the down-arrow at the 
bottom of the ‘New Slide’ button, and select the desired layout.
(You can also change the layout of any page, at any time, by selecting it 
from the ‘Layout’ drop-down, just to the right of the ‘New Slide’ button.)



Classification Identification
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Classification Identification in Footer
Change footer if necessary to indicate appropriate classification of information:

Public, Internal, Confidential, Restricted

To change:
Go to ‘View’ Tab

Select ‘Slide Master’

Be sure you are on the Main Master (#1)

Edit text as necessary

Click on the ‘Close Master View’ button
to return to edit mode



Opening & Closing Slides
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The PowerPoint Theme.thmx’ includes a blue-
background opening slide (which gets created 
automatically as the first page when you double-click 
on the theme file to start a new presentation).

The theme file also includes a plain blue closing slide. 
You should add this slide as the final slide in your 
presentations.

Note: Please be environmentally conscious

§ Don’t print unless necessary

§ When printing, specify pages / page range to avoid 
printing blank end-pages and other content-free pages

§ Print in b/w if color is not required

Opening and Closing Slides



Fonts & Colors



12Internal

Slide Titles
§ Calibri 32 Point (Limit to One Line)

Body text
§ Calibri
§ The first line of body text is non-bulleted
§ Indented text has square bullets

§ Sub-bullet - font size decreases by two sizes with each indent
§ Color is dark gray (80%), found in the Colors palette

• Capitalize first letter 
of words longer than 
2-3 characters (‘to’, 
‘and’, etc. need not 
be capitalized)

• Use ampersand (‘&’) 
where you can

Fonts - Slide Titles and Body Text
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First line – no bullet (default 26 pt.)
§First indent (24 pt.)

§ Second (22 pt.)
§ Third (20 pt.)

§ Fourth (18 pt.)

Body Text

Font sizes should decrease by 2 pts.
with each indent.

If you re-size text using the buttons for
‘Increase Font Size’
or 
‘Decrease Font Size’,
PowerPoint may, or may not keep 
the correct font sizes. So please double-check 
and make any necessary adjustments
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Body Text
To create properly formatted body text, select a layout (from the New Slide or 
Layout dropdown) that includes body text elements (“Main Content” or 
“2 Column” layout). These elements use this format by default.
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Inside Lines

Outside Border Lines

Colors for Tables

Colors for tables with  1 Header Row

2

w

1

Use the “Ice Blue” family of colors, which is part of the Presentation color scheme which is 
embedded into the PowerPoint Theme.thmx

Header Row

Body Rows

3

2

w

1

Colors for tables with  2 Header Rows

Sub-Header Row

Body rows

Main Header Row

Ice Blue

1
2
3

w

Outside border line: 
Blue, 

¾ point thickness

Inside Lines: 
Gray, 

¾ point thickness
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RGB Color Values (continued)

Font Blue Red Amber Green
R
G
B

77
77
77

R
G
B

0
130
170

R
G
B

255
0
0

R
G
B

255
161

0

R
G
B

146
208

80

All 4 BRAG colors are available 
in the color palette under 

Theme Colors and Standard Colors

Click on the Custom tab to enter 
RGB values for colors

or



Formatting Tables
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Note: All tables in the Samples and Appendix Slides.pptx presentation have sample data in them

There are two general methods for using tables from the ‘Samples and 
Appendix Slides.pptx’ deck:

1. Manually Enter Data (Simple)

1) Copy & paste a table into your working document

2) Manually change the data

2. Copy & Paste Data (Complex)

1) Copy & paste a table into your working document

2) Copy & paste data from an existing source document to 
replace sample data

Using Sample Tables
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This method is fairly straight forward: 
1. From the Sample Tables section of the Samples and Appendix Slides.pptx, 

choose the table that meets your needs

2. Copy table and paste it into your working presentation

3. Add or remove rows and columns as required 
§ Note: Be sure to apply the correct fill color to all new lines and/or columns that 

you add, as well as making sure the table is outlined in blue (see ‘Colors for Tables 
and Charts’ and the ‘Re-Apply Blue Border to Tables’ section, elsewhere in this 
deck).

4. Manually enter new data to replace existing data

§ Be sure to use correct font, font size, color, etc.

Tables: Method 1 (Manually Enter Data)
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Tables: Method 2 (Copy & Paste Data)
The instructions on these pages describe how to copy & paste data from an existing source (such as an Excel 
spreadsheet) into a sample table, and make the necessary adjustments to ensure that your tables have the 
appropriate style – Look & Feel - throughout your presentation.

Select and copy the source data (other table or Excel 
spreadsheet) 

1 2
Choose the table  that meets your needs from the Sample 
Tables section of the Samples and Appendix Slides.pptx. Copy 
& paste it into your working presentation.

Title Title

Text 25
Text 30
Text 35
Text 40
Text 45
Text 50
Text 55
Text 60
Grand Total 340

ExampleExample
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Tables: Method 2 (Copy & Paste Data)(cont.)
Important: In your working presentation, before 
pasting data, modify the number of rows and 
columns of the newly-pasted table, to match the 
number of rows and columns in the source data. 

Month # of Emails
January 3,339
February 4,749
March 3,225
April 3,369
May 4,309
June 3,389
July 3,407
August 3,425
September 3,132
Grand Total 32,344

Manually change all attributes such as font, font color, font 
size, alignment, cell padding, etc., to make the chart 
conform to the required style.
Note: You may be able to save some formatting time and 
effort if you can change the formatting of your source 
document to match the destination formatting – if you 
modify your source document with the correct font, font 
size, color, etc., before the Copy & Paste operation, those 
attributes should then be retained when pasted into the new 
table, limiting the amount of re-formatting necessary in the 
destination table. 

43

Example

!
PowerPoint will not automatically create additional rows and/or 
columns to accommodate pasted data – any pasted data that 
does not fit into the current table will not be copied – it will be 
lost.
Note: if you remove rows or columns, be sure to see the ‘Re-Apply 
Blue Border to Tables’ section elsewhere in this deck
In the destination table, place your cursor in the top left cell, right-
click, and from Paste Options, select “Use Destination Styles”. This 
will paste the data into the table, and will retain some table 
formatting attributes, such as row colors, but it will probably not 
retain attributes such as font, font color, alignment, and others.

When completed, 
table should look 
like source table 
(fonts, row colors, 
blue outline, etc.)

Month # of Emails
January 3,339 
February 4,749 
March 3,225 
April 3,369 
May 4,390 
June 3,389 
July 3,407 
August 3,425 
September 3,132 
Grand Total 32,425 

When source 
data is pasted, 
table formatting 
will be retained, 
but fonts, font 
colors, etc., will 
need to be 
modified

Example



Re-Apply Blue Border to Tables
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Re-Apply Blue Border to Tables

Re-apply the blue border
(This is a high-level overview, details are on the following pages)
If you remove rows or columns, and have to re-apply the blue border:

1. Click on edge of table to select the entire table (be sure you’ve selected the entire table, 
not just a cell within it)

2. With the table selected, go to the “Table Tools” in the ribbon, and click on the ‘Design” 
tab

3. Make these settings:
1) Set border style as solid
2) Set Pen Weight to ¾ pt
3) Set “Pen Color” to “Turquoise, Text 1”

With parameters set, and table selected:
1) Click on the ‘Borders’ selection drop-down arrow  
2) Choose “Outside Borders” to apply the settings to the outside border of the table
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Re-Apply Blue Border to Tables (Details)

Title

content content content

content content content

content content content

content content content

content content content

content content content

content content content

content content content

Title

content content

content content

content content

content content

content content

content content

If you delete rows or columns, you will ‘lose’ 
the blue border around the outer edge
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Re-Apply Blue Border to Tables (Detail) (cont.)

§ Click on edge of table to select  the entire table (you will see a thick selection border around 
the table) (Be sure you’ve selected the entire table, not just a cell within it)
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Set Table Border Parameters

1. With the table selected, go to the “Table Tools” 
in the ribbon, and click on the ‘Design” tab.

2. Make these settings:

1. Set border style as solid

2. Click on Pen Weight and set to ¾ pt

3. Click on “Pen Color”, 
and select “Turquoise, Text 1” 
as the color (You will notice that this is the same 
‘blue’ color that we are using in our BRAG status 
colors)
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Apply Table Border

With parameters set, and table selected:

1. Click on the ‘Borders’ selection drop-down arrow,  

2. Choose “Outside Borders”, 
to apply the settings to the 
outside border of the table
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Table Border - Complete

Title

content content

content content

content content

content content

content content

content content

Your table border should look like this:



Size and Position of Tables
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Size and Position for Full-Width Tables

Title

content content content content content content

content content content content content content

content content content content content content

content content content content content content

content content content content content content

content content content content content content

content content content content content content

content content content content content content

See next page for details on size and position 
of a full-size table like this one
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Set Size and Position

1. Click on the table to select it (you will see a 

thick gray outline, indicating that the table is 

selected)

2. Click on the ‘Layout” tab under “Table Tools”

3. In the “Width” dialog box, set the width to 9”

Width: 9”

4. Right-click on the 

table, and select 

“Format Shape…” 

5. Click on the ‘Position’ tab

6. Set Horizontal to 0.5” from top left corner

7. Set Vertical to 1.25 from Top Left Corner

Horizontal:

Vertical:

0.5”

1.25”



Formatting Charts
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Using Sample Charts

Note: All charts in the Samples and Appendix Slides.pptx presentation have 
sample data in them

There are two general methods for using charts from the ‘Samples and 
Appendix Slides.pptx’ deck:

1. Manually Enter Data (Simple)

1) Copy & paste a chart into your working document

2) Manually change the data

2. Copy & Paste Data (Complex)

1) Copy & paste a chart into your working document

2) Copy & paste data from an existing source document to replace 
sample data
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Note: All charts in the Samples and Appendix Slides.pptx presentation have 
sample data in them

1. From the Samples and Appendix Slides.pptx presentation, choose the chart 
that meets your needs and select “Copy”)

2. Paste it into your working presentation by right-clicking, and under “Paste 
Options”, select “Use Destination Theme, & Embed Workbook”

3. Right-click on the newly-pasted chart, then select ‘Edit Data…”
§ This will launch the Excel spreadsheet that contains the data for the chart 
§ The data may be within a blue bounding box…
§ … however, you may only see a small blue ‘corner’, representing the lower-right 

corner of the bounding box
4. Manually enter data to replace the existing data in the spreadsheet
5. If necessary, drag the small blue ‘corner’ to encompass only the data you wish 

to display in the chart. You can then close the spreadsheet.
6. In the presentation, adjust/re-format table elements as necessary, such as 

manually moving, re-sizing or changing color of data labels and other elements

Charts: Method 1 (Manually Enter Data)
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Charts: Method 2 (Copy & Paste Data)

Note: All charts in the Samples and Appendix Slides.pptx presentation have 
sample data in them

1. From the Samples and Appendix Slides.pptx presentation, choose the chart that meets your 
needs, copy chart and paste it into your working presentation

2. Access the source data (Excel spreadsheet) you wish to use for your chart – select and copy 
the desired data

3. In your working presentation, right-click on the newly-pasted chart, then select ‘Edit Data…”
§ This will launch the Excel spreadsheet that contains the data for the chart 

§ The data may be within a blue bounding box…

§ … however, you may only see a small blue ‘corner’, representing the lower-right corner of 
the bounding box

4. Delete the existing data, and paste your source data into the spreadsheet

5. If necessary, drag the small blue ‘corner’ to encompass only the data you wish to 
display in the chart

§ Note that this should only be necessary if you paste less data (fewer lines and/or columns) 
than the chart’s sample data. If you paste more data (more lines and/or columns of data) the 
bounding box will automatically expand to encompass all the newly-pasted data.

6. Close the spreadsheet

7. In the presentation, adjust/re-format table elements as necessary, such as manually 
moving, re-sizing or changing color of data labels and other elements




